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RENCANA PERLAKSANAAN PEMBELAJARAN
TEKNIK KOMPUTER DAN INFORMATIKA

Identitas Sekolah : SMAN 5 Tambun Selatan

Guru Mata Pelajaran : Muhammad Syamsudin, S.Kom

Mata Pelajaran : Tekhnologi Informasi dan Komunikasi
Kelas/Semester : XIGenap

Materi Pokok : Dasar Desaign Grafis

Pertemuan 01

Alokasi Waktu : 2 X 45 Menit (1 x Pertemuan)-RPP Luring

A. Kompetensi Inti
Kl 3.

Memahami, menerapkan, menganalisis, dan mengevaluasi tentang pengetahuan
faktual, konseptual, operasional dasar, dan metakognitif sesuai dengan bidang dan
lingkup kerja Dasar-dasar Teknik Komputer dan Informatika pada tingkat teknis,
spesifik, detil, dan kompleks, berkenaan dengan ilmu pengetahuan, teknologi, seni,
budaya, dan humaniora dalam konteks pengembangan potensi diri sebagai bagian
dari keluarga, sekolah, dunia kerja, warga masyarakat nasional, regional, dan
internasional.

Kl 4.

Melaksanakan tugas spesifik, dengan menggunakan alat, informasi, dan prosedur
kerja yang lazim dilakukan serta menyelesaikan masalah sederhana sesuai dengan
bidang dan lingkup kerja Dasar-dasar Teknik Komputer dan Informatika
Menampilkan kinerja mandiri dengan mutu dan kuantitas yang terukur sesuai
dengan standar kompetensi kerja. Menunjukkan keterampilan menalar, mengolah,
dan menyaji secara efektif, kreatif, produktif, kritis, mandiri, kolaboratif, komunikatif,
dan solutif dalam ranah abstrak terkait dengan pengembangan dari yang
dipelajarinya di sekolah, serta mampu melaksanakan tugas spesifik dibawah
pengawasan langsung. Menunjukkan keterampilan mempersepsi, kesiapan,
meniru, membiasakan gerak mahir, menjadikan gerak alami, sampai dengan
tindakan orisinal dalam ranah konkret terkait dengan pengembangan dari yang
dipelajarinya di sekolah, serta mampu melaksanakan tugas spesifik dibawah
pengawasan langsung.

B. Kompetensi Dasar dan Indikator Pencapaian Kompetensi

Kompetensi Dasar Indikator Pencapaian Kompetensi
3.6 Menerapkan 3.6.1 Menguraikan ciri-ciri gambar vektor
perangkat lunak 3.6.2 Menjelaskan macam-macam perangkat lunak
pengolah gambar pengolah gambar vektor
vektor
4.6. Menggunakan 4.6.1 Mendemonstrasikan macam-macam perangkat
perangkat lunak pengolah gambar vector
lunak
pengolah
vektor

C. Tujuan Pembelajaran

1.

Melalui pengamatan bahan ajar, peserta didik dapat mengemukakan ciri-cCiri

gambar vector dengan benar.

. Melalui pengamatan bahan ajar, peserta didik dapat mengemukakan macam-
macam perangkat lunak pengolah gambar vektor dengan benar.

. Setelah melihat praktikum, peserta didik dapat mengoperasikan macam-macam

perangkat lunak pengolah gambar vektor dengan benar dan disiplin.



D. Materi Pembelajaran
1. Ciri-ciri gambar vektor
2. macam-macam aplikasi pengolah gambar vektor

E. PENDEKATAN, MODEL DAN METODE
Pendekatan

Model Pembelajaran

Metode

F. Media/Bahan/Alat

1. Media

2. Alat

3. Sumber Belajar

:Saintifik
:Discovery Learning

:Diskusi, Simulasi, Praktik

Form,FastStone Capture,Video Editor

: Laptop, Personal Computer,windows 7/8/10, Coreldraw

X6,Libre CAD dan Open Office Draw

: Handout, LKPD dan Internet

G.Kegiatan Pembelajaran

: Slide Powerpoint, Google Classroom, Google Meet, Google

No | Deskripsi Guru Siswa Alokasi
Kegiatan Waktu
1. | Pembukaan 1. Membuka kelas online 1. Memperhatikan dan 5
dengan memberikan menjawab salam
salam
2. Menyapa siswa dengan | 2. Menyambut sapaan
sapaan tentang kabar di secara aktif dan
rumah, memberi berinteraksi
semangat dan motivasi
belajar
3. Menyampaikan rambu- | 3. Menyimak dan mengikuti
rambu serta hal-hal rambu-rambu yang telah
teknis terkait ditentukan
pembelajaran yang
berlangsung
4. Mengajak berdoa 4. Mengikuti berdoa
bersama bersama
5. Melakukan absensi 5. Menjawab absensi
kehadiran siswa dan kehadiran dan mengisi
meminta siswa mengisi presensi hadir pada
presensi hadir di google google form
form
6. Memberikan apersepsi 6. Memperhatikan
apersepsi
7. Menjelaskan tujuan 7. Menyimak dan
pembelajaran yang akan Memahami tujuan
dicapai. pembelajaran yang
ingin dicapai
2 Kegiatan Inti
Literasi

< Mengamati

1. Meminta peserta didik
untuk mencermati
tayangan gambar
sehubungan dengan ciri-
ciri gambar vektor dan
macam-macam aplikasi
pengolah gambar
vektor(stimulus)

1. Mencermati tayangan
gambar sehubungan
dengan ciri-ciri gambar
vektor dan macam-
macam aplikasi
pengolah gambar vektor

+ Menanya

2. Memberikan pertanyaan
sehubungan dengan
gambar yang

2. Menjawab pertanyaan
yang diberikan




ditampilkan

s Mengumpul
kan
informasi

3. Meminta ke peserta didik
untuk mencermati bahan
ajar sehubungan dengan
ciri-ciri gambar vektor
dan macam-macam
aplikasi pengolah
gambar vector

3. Mencermati tayangan
bahan ajar

4. Memberikan contoh
praktek mengoperasikan
macam-macam aplikasi
pengolah gambar vektor

4. Memperhatikan dan

mencermati contoh

praktik mengoperasikan
macam-macam aplikasi
pengolah gambar vektor

* Mengolah
infromasi

1. Memberikan tugas
kepada peserta didik
untuk mengerjakan
LKPD

1. Mengerjakan LKPD

2. Menugaskan peserta
didik untuk
Mengoperasikan macam-
macam aplikasi pengolah
gambar vektor sesuai
LKPD

2. Mengoperasikan
macam-macam aplikasi
pengolah gambar vektor
sesuai LKPD

s Menyimpul
kan

3. Meminta peserta didik
untuk menyimpulkan
hasil pengerjaan LKPD
nya
{mengkomunikasikan}

3. Memberikan
kesimpulannya
{mengkomunikasikan}

Kegiatan
Penutup

1. Sebelum pelajaran
ditutup,meminta siswa
melakukan refleksi
kesimpulan kegiatan hari
ini. Kegiatan refleksi
berikut ini:

a. Apa yang telah kamu
pelajari hari ini?

b.Apa yang paling kalian
sukai dari pembelajaran
hari ini?

c. Apa yag belum kaian
pahami pada
pembelajaran hari ini?
(Mengkomunikasikan)

1. Melakukan refleksi
kesimpulan kegiatan
hari ini. Kegiatan
refleksi berikut ini:

a. Apayang telah
pelajari hari ini?

b. Apa yang paling
disukai dari
pembelajaran hari
ini?

c. Apayag belum
dipahami pada
pembelajaran hari
ini?
(Mengkomunikasikan

)

2. Pemberian tugas yang
tertera pada LKPD

2. Mengerjakan tugas
secara mandiri diluar
jam online dengan
rincian/tahapan yang
suduah diinstruksikan
oleh guru (terlampir)

3. Menyampaikan
rencana kegiatan
pembelajaran  untuk
pertemuan berikutnya

3. Menyimak dan
mengamati

4. Memberikan penguatan
dan motivasi kepada
murid untuk tetap

4. Menunjukkan sikap aktif
dan berinteraksi dengan
tanggapan singkat




semangat dalam
mengikuti pembelajaran
daring

5. Mengajak berdoa 5. Mengikuti doa
bersama

6. Menutup pembelajaran 6. Menjawab Salam
dengan mengucapkan
terima kasih dan
mengakhirinya dengan
salam.

F. Penilaian Hasil Belajar :

a. Penilaian Sikap : Diamati langsung oleh guru selama proses pembelajaran melalui

layar monitor meliputi disiplin dan mandiri.

b. Penilaian Pengetahuan : Penilaian dalam bentuk quiz online Google form untuk
mengukur penguasaaan siswa terhadap materi yang telah
dipelajari dan didiskusikan dalam kelas daring.

c. Penilaian Keterampilan : Aktivitas proses diawal praktek hingga selesai kegiatan
praktek secara daring melalui google classroom

G.PROGRAM TINDAK LANJUT
1. Remedial
e Peserta didik yang belum mencapai KKM (76) diberi tugas untuk menuliskan
perbedaan aplikasi pengolah gambar vektor terkait kegiatan selama satu
minggu. Setelah satu minggu guru mengevaluasi kemajuan kompetensi
peserta didik dalam menangkap penggunaan aplikasi pengolah gambar
vektor. Kemudian guru melaksanakan penilaian remedial.

2. Pengayaan
e Bagi peserta didik mempunyai nilai di atas 76 diberi pengayaan berupa tugas
mandiri untuk menelaah fungsi dasar aplikasi coreldraw untuk desain grafis.

Tambun Selatan,..... Januari 2022

Kepala Sekolah Guru Bidang Study

Riagung Prastyo, S.Si.,M.Pd Muhammad Syamsudin, S.Kom

NIP.197507262003111001 NIP.198403262021211001
Lampiran :

1. LKPD (Lembar kerja Peserta Didik)
2. Bahan Ajar/Handout



Nama Sekolah

Guru Mata Pelajaran
Materi Pokok

Tofik
Kelas/Semester

Alokasi Waktu

Identitas Sekolah :

: SMAN 5 Tambun Selatan
: M. Syamsudin, S.Kom

: Dasar Desain Grafis

: Menggunakan aplikasi pengolah gambar vektor
: X/ Semester 2

: 2x45 Menit

Nama Siswa

Kelas




KEGIATAN BELAJAR 1

A.

Kompetensi Dasar :
3.6 Menerapkan perangkat lunak pengolah gambar vektor
4.6 Menggunakan perangkat lunak pengolah vektor

Indikator Pencapaian Kompetensi :

3.6.1 Menguraikan ciri-ciri gambar vektor

3.6.2 Menjelaskan macam-macam perangkat lunak pengolah gambar
vektor

4.6.1 Mendemonstrasikan macam-macam perangkat lunak pengolah
gambar vector

Tujuan Pembelajaran

1. Melalui pengamatan bahan ajar, peserta didik dapat mengemukakan
ciri-ciri gambar vector dengan benar.

2.Melalui pengamatan bahan ajar, peserta didik dapat mengemukakan
macam-macam perangkat lunak pengolah gambar vektor dengan
benar.

3. Setelah melihat praktikum, peserta didik dapat mengoperasikan
macam-macam perangkat lunak pengolah gambar vektor dengan
benar dan disiplin.

. Alat dan Bahan:

1. Alat : Personal Computer/Laptop
2.Bahan : Aplikasi Coreldraw, Libre CAD,Open Office Draw dan
Windows 10

. Petunjuk Belajar

1. Amati video pembelajaran yang ada di google classroom
2. Kerjakan penugasan sesuai petunjuk yang tertera pada soal



Tugas Kognitif

1. Melalui pengamatan bahan ajar yang kamu pelajari, sebutkan ciri-
ciri gambar vektor ?

2. Menurut informasi yang kamu dapatkan dari bahan ajar,sebutkan
macam-macam perangkat lunak pengolah gambar vektor ?

Langkah-langkah Praktek

% Perhatikan dan cermati langkah-langkah mengaktifkan aplikasi, membuka file,
menyimpan file dan keluar dari aplikasi coreldraw,Libre CAD dan Open Office
Draw

A. Mengaktifkan perangkat lunak pengolah vector coreldraw X6

1. Klik Star->Pilih Corel draw Graphics Suite X6->Pilih Coreldraw X6 (64-Bit)

B CoreiDRAW Graphics Suite X6 (6... ~

- Bitstream Font Navigator (64-Bit)

@ Corel CAPTURE X6 (64-Bit)

®.  Corel CONNECT X6 (64-Bit)

8 Corel PHOTO-PAINT X6 (64-Bit)
m CorelDRAW Graphics Suite X6 Gui...
#®  Duplexing Wizard (64-Bit)

E Macro Programming Guide

#2  video Tutorials X6 (64-Bit)

B. Mengaktifkan perangkat lunak pengolah vector Open Office Draw

1. Klik Star ->Open Office 4.1.7->Pilih Open office Draw->Muncul lembar kerja
l OpenOffice 4.1.7 2

OpenOffice

OpenOffice Base

OpenOffice Calc
OpenOffice Draw
New

OpenOffice Impress

OpenOffice Math

OpenOffice Writer

NEW

C. Mengaktifkan perangkat lunak pengolah vector Libre CAD

1. Klik Star->Pilih folder Libre CAD—>klik Libre CAD->Muncul lembar kerja



libreCAD

) LibreCAD
T

Membuat Dokumen Pada aplikasi Coreldraw

Langkah-langkahnya sebagai berikut :

1. Klik menu file=>Pilih New > Tentukan nama judul, ukuran, unit, jumlah lembar kerja,
Pewarnaan dan resolusi
2. Kemudian pilih “ok”

Create a New Document x

Mame: | |

Preset destination: | Custom ~ |
Size: | Legal e
Width: |21.59am  5-|| centimeters i

-

af=
Mumber of pages:

Primary color mode: | CMYK e
Rendering resolution: o | dpi
Preview mode: |Enhanced ~
¥ Color settings
% Description

Lets you select the preview mode that most resembles the final output of
your document.

[CJ oo not show this dialog again

OK Cancel Help

Membuka Dokumen Pada aplikasi Coreldraw

Langkah-langkahnya sebagai berikut :

1. Klik Menu file->Pilih open->Pilih file yang diinginkan->kemudian pilih open

LY CorelDRAW X6 (64-Bit) - [Untitled-1]

(7 New.. Ctrl+N
M Open. Ctrl+0
Ley Open Recent ¢
E.D Close
J B Clace Al

Menyimpan Dokumen pada aplikasi Coreldraw

Langkah-langkahnya sebagai berikut :

1. Klik File->Save—>(jika ingin menggunakan nama file default dari aplikasi)=>kemudian pilih save
2. Klik File>Save As—>(jika ingin menggantinya dengan nama file yang baru)—=>kemudian pilih save



L CorelDRAW X6 (64-Bit) - [Untitled-1]

hY Fie |

o T Mew.. Ctrl+N
P~ Open. Ctrl+0
== Open Recent 3

% Close

“«F  Closeal

. o
Cw swess.
= Save As Template...

Mengakhiri lembar kerja pada aplikasi Coreldraw

Langkah-langkahnya sebagai berikut :

1. Klik File=>Pilih Exit

D |
o3 (T Mew.. Ctrl+N
P~ Open.. Ctrl+ O
Leg Open Recent >
Rg ﬁ;‘) Close
4 “[F  Close Al
Y. Save..
[ Saveds
O[5 SaveAs Tem)
-:N Revert
% Acguire Image 4
O Search Content
O‘ S Import... Ctrl+|
U Export...
- % Export For Office...
|4%  Export For Web...
[0@s  Export HTML..
@[ SendTo
= Print... |
% [ Print Merge |
Print Preview...
lj; |=|? Print Setup...
Q‘ |&&  Collect For Output... |
é]@ Publish To PDF... |
B [¥&  Publish Page To ConceptShare... |
- Document Properties,..
[ Exit Alt+F4

Langkah-langkah membuat lembar kerja pada aplikasi Libre CAD ]

Langkah-langkahnya sebagai berikut :

1. Klik menu file=>Pilih New = Lakukan pada pengaturan warna background,unit dan penyimpanan

= Application Preferences ? X
Appearance  Paths  Defaulis

Graphic vien Graphic Colors
Snzp indicator nes Crasshar - snspmdcston =
Snap indicator shape Cirdle - ok
[ Hide cursor when snapping

Meta Grd Coor =
[ Anti-alizsing

Selected Color: FAS4747 ~| |-
Scrollbars

Highlighted Color: #739373 ~| |-
Automatically scale orid

StartHondle Colo: =
Hinina Grid Spacing (px):
Number of preview entities: 100 hd

End Handle Coor =
Language
GUI Language: Engiish -
Command Language: Engiish -

Langkah-langkahnya sebagai berikut :

1. Klik Menu file=>Pilih New—>Pilih Drawing



ﬁ Untitled 1 - OpenOffice Draw

‘| Eile Edit View Insert Format Tools Modify Window Help

Digital Signatures...

Templates

Preview in Web Browser

ﬂ Print... Ctrl+P
Printer Settings...
2] Exit Ctrl+Q

TUGAS PSIKOMOTOR

1. Buatlah

10 Mew »| [ TextDocument
1 Open... Ctr+0 | B Spreadsheet
1 Recent Documents 2 Presentation
| & Wizards , i Drawing Ctrl+N
{8 Database
“ @ Close
| Save Cufes | B HTML Document
B SaveAs.. Ctrl+Shift+S i XML Form Document
Save All E4  Master Document
Reload £ Formula
Versions... 2 Labels
[% Export... 2 Business Cards
ERERT R T Templates and Documents
Send '
ETJ Properties... HIE

©
-~

o

langkah-langkah
menyimpan file dan keluar dari aplikasi coreldraw,Libre CAD dan Open
Office Draw. kemudian screenshot hasilnya dan tempel pada kotak

dibawah ini !

a. Mengaktifkan aplikasi Coreldraw, screenshoot dan tempel pada kotak

dibawah ini

b. Membuka file pada aplikasi Coreldraw, screenshoot dan tempel pada
kotak dibawah ini

mengaktifkan membuka




c. Menyimpan file pada aplikasi Coreldraw, screenshoot dan tempel
pada kotak dibawah ini

d. keluar dari aplikasi Coreldraw, screenshoot dan tempel pada kotak
dibawah ini

e. Mengaktifkan aplikasi Libre CAD, screenshoot dan tempel pada kotak
dibawah ini

f. Membuka file pada aplikasi Libre CAD, screenshoot dan tempel pada
kotak dibawah ini




g. Menyimpan file pada aplikasi Libre CAD, screenshoot dan tempel
pada kotak dibawah ini

h. keluar dari aplikasi Libre CAD, screenshoot dan tempel pada kotak
dibawah ini

i. Mengaktifkan aplikasi Open Office Draw, screenshoot dan tempel
pada kotak dibawah ini

j. Membuka file pada aplikasi Open Office Draw, screenshoot dan
tempel pada kotak dibawah ini




k. Menyimpan file pada aplikasi Open Office Draw, screenshoot dan
tempel pada kotak dibawah ini

|. keluar dari aplikasi Open Office Draw, screenshoot dan tempel pada
kotak dibawah ini

F.Pedoman Penskoran Kognitif (Penilaian dibawah ini tidak
dilampirkan pada LKPD siswa)

No Soal Alternatif Jawaban Skor
1 Jika menjawab soal dengan tepat 10-20

2 akan mendapatkan skor 10-20

3 maksimal, jika tidak maka akan 10-20

4 dikurangi 10-20

5 10-20
Total SKor 100

G. Rubrik Penilaian:
Lembar Penilaian Sikap - Observasi pada Kegiatan Diskusi

Mata Pelajaran L e

Kelas/Semester L e

Topik/Subtopik L s

Indikator : Peserta didik menunjukkan perilaku kerja
sama, santun, toleran, responsif dan proaktif serta bijaksana sebagai wujud
kemampuan memecahkan masalah dan membuat keputusan.

Nama | Tepat < e 1 . .
No Siswa | waktu Disiplin | Komunikatif | Keterangan
1
2

Kolom Aspek perilaku diisi dengan angka yang sesuai dengan kriteria
berikut.




4 = sangat baik
3 = baik

2 = cukup

1 = kurang

H. LEMBAR PENILAIAN KETERAMPILAN - UNJUK KERJA

Tabel : Rubrik Penilaian Unjuk Kerja

Tingkat Kriteria

4 Jawaban menunjukkan penerapan konsep mendasar vyang

berhubungan dengan tugas ini.

Ciri-ciri:

Semua jawaban benar, sesuai dengan prosedur operasi dan
penerapan konsep yang berhubungan dengan tugas ini

3 Jawaban menunjukkan penerapan konsep mendasar vyang
berhubungan dengan tugas ini.

Ciri-ciri:
Semua jawaban benar tetapi ada cara yang tidak sesuai atau ada
satu jawaban salah. Sedikit kesalahan perhitungan dapat diterima

2 Jawaban menunjukkan keterbatasan atau kurang memahami
masalah yang berhubungan dengan tugas ini.

Ciri-ciri:
Ada jawaban yang benar dan sesuai dengan prosedur, dan ada
jawaban tidak sesuai dengan permasalahan yang ditanyakan.

1 Jawaban hanya menunjukkan sedikit atau sama sekali tidak ada
pengetahuan bahasa Inggris yang berhubungan dengan masalah
ini.

Ciri-ciri:

Semua jawaban salah, atau

Jawaban benar tetapi tidak diperoleh melalui prosedur yang
benar.

0 Tidak ada jawaban atau lembar kerja kosong

No Nama Siswa Tingkat Nilai Ket.

4 3 2 1

WIN |

“"Hiduplah seolah engkau mati besok. Belajarlah seolah engkau hidup
selamanya”. (Mahatma Gandhi)

SELAMAT MENGERJAKAN




AHAN AJAR/HANDOUT

SMAN 5

TAMBUN SELATAN

MATA PELAJARAN
DASAR DESAIN GRAFIS

KELAS X SEMESTER GENAP
TAHUN PELAJARAN 2021/2022

SMAN 5 TAMBUN SELATAN

JI. Sunset Ave Grand Wisata-Tambun Selatan
Telp: (021) 8250468 - Fax. (021) 8250468
Website : wvw.sman5tamsel.sch.id E-mail ;: info@sman5tamsel.sch.id



http://www.sman5tamsel.sch.id/
mailto:info@sman5tamsel.sch.id

Handsout
TIK

Grafis berbasis vekleog_ B

Identitas Sekolah ¢

Nama sekolah : SMAN 5 Tambun Selatan

Guru Mata Pelajaran : M. Syamsudin, S.Kom

Mata Pelajaran : Teknologi Informasi dan Komunikasi
Materi Pokok : Dasar Desain Grafis

Tahun Pelajaran : 2021-2022

Kelas/Semester : X / Semester 2



Handout

TIK SMA Kelas X Semester Genap

Komptensi Dasar

3.6 Menerapkan perangkat lunak Pengolah Gambar Vector
4.6 Menggunakan perangkat lunak Pengolah Gambar Vector

Indikator

3.6.1 Menguraikan contoh gambar vektor
3.6.2 Menjelaskan macam-macam perangkat lunak pengolah gambar vector
4.6.1 Mendemonstrasikan macam-macam perangkat lunak pengolah gambar vector

Tujuan Pembelajaran

4. Melalui pengamatan video youtube, peserta didik dapat mengemukakan contoh
gambar vector dengan benar.

5. Melalui pengamatan video youtube, peserta didik dapat mengemukakan macam-
macam perangkat lunak pengolah gambar vektor dengan benar.

6. Setelah menonton media tutorial, peserta didik dapat mengoperasikan macam-
macam perangkat lunak pengolah gambar vektor dengan benar.



Pela Kearep Pemnbelajaian

Contoh Gambar Vektor

Perangkat Lunak Mengenal Perangkat Lunak

Pengolah gambar Vektor Pengolah Vektor

Mengoperasikan jenis-jenis
Perangkat Lunak Pengolah



Grafis adalah gambar yang tersusun dari koordinat-koordinat. Dengan demikian sumber gambar yang

muncul pada layar monitor komputer terdiri atas titik-titik yang mempunyai nilai koordinat. Layar

Monitor berfungsi sebgai sumbu koordinat x dan y. Vector adalah gambar yang terbuat dari beberapa

titik dan garis (poligon), kombinasi gambar jenis ini melalui proses rumus matematika khusus dalam
pembuatan gambar. Setiap alur vector dapat dengan mudah ditambah atribut untuk membuat berbagai
bentuk yang diinginkan. Vector juga dapat ditambahkan dan menghilangkan atribut seperti ketebalan

garis, warna, warna isi, nodes dan lainnya. Aplikasi yang digunakan untuk mengolah gambar vector

antara lain : Adobe lllustrator, Corel Draw, Autocad,open office Draw, Libre CAD dll.

Ciri-ciri grafis berbasis vector, anatara lain :

1)
2)
3)
4)
5)
6)

Tersusun oleh kurva (path).

Bersifat resolution independent.

Cocok untuk pembuatan gambar dengan warna sederhana.
Gradasi warna harus diolah oleh desainer.

Menyimpan gambar dengan format tertentu.

Nyaman digunakan untuk melayout.

Contoh Gambar Vektor

4

Gambar 1.1 Gambar 1.2

a P

Gambar 1.3 Gambar 1.4

[ Mengenal aplikasi pengolah gambar vektor ]

Aplikasi Corel Draw

> Aplikasi Open Office Draw

>



Pengertian Aplikasi Corel Draw

Coreldraw adalah sebuah perangkat lunak komputer yang dikembangkan oleh Corel Corporation.
Perusahaan tersebut merupakan sebuah perusahaan perangkat lunak yang basisnya berada di Ottawa,
Kanada. Jika dipahami secara umum, fungsi dari CoreIDRAW adalah pengolah gambar. Dengan berbagai
keunggulan yang dimiliki dari CorelDRAW, maka tidak heran jika perangkat lunak ini banyak digunakan
pada bidang publikasi, percetakan, serta berbagai jenis bidang lain yang membutuhkan proses visual.

Pengertian Aplikasi Open Office Draw

OpenOffice.org Draw merupakan program OpenOffice.org untuk menggambar vector. Fungsi dan
toolbarnya hampir sama dengan OpenOffice.org lainnya, hanya terlihat perbedaan sedikit pada
format lembaran kerjanya yang menggunakan lembaran kerja kertas gambar.OpenOffice.org Draw
tak lepas dari menggunakan toolbar,sebab kebanyakan peralatan menggambar terpampang pada
toolbar.

CAD (Computer Aided Design) merupakan aplikasi untuk membuat rancangan dengan bantuan
komputer 2D (CAD) untuk membangun gambar-gambar grafis mekanik. Oleh karena itu, aplikasi ini
sangat cocok untuk membuat cetak biru bagi seorang insinyur, arsitek ataupun draft-men.

Langkah-langkah mengaktifkan perangkat lunak pengolah vektor

A. Mengaktifkan perangkat lunak pengolah vector coreldraw X6

1. Klik Star=>Pilih Corel draw Graphics Suite X6—>Pilih Coreldraw X6 (64-Bit)

l CorelDRAW Graphics Suite X6 (6... ~
-« Bitstream Font Navigator (64-Bit)
,_‘ Corel CAPTURE X6 (64-Bit)
Corel CONNECT X6 (64-Bit)
Corel PHOTO-PAINT X6 (64-Bit)

CorelDRAW Graphics Suite X6 Gui...

™ CorelDRAW X6 (64-Bit)

Duplexing Wizard (64-Bit)

E Macro Programming Guide

%8  video Tutorials X6 (64-Bit)

Gambar 1.5 Mengaktifkan aplikasi coreldraw

B. Mengaktifkan perangkat lunak pengolah vector Open Office Draw

1. Klik Star >Open Office 4.1.7->Pilih Open office Draw—>Muncul lembar kerja



l OpenOffice 4.1.7

OpenOffice

OpenOffice Base

penOffice Calc

OpenOffice Draw

New

OpenOffice Impress

OpenOffice Math

OpenOffice Writer

New

Gambar 1.6 Mengaktifkan aplikasi open office Draw

C. Mengaktifkan perangkat lunak pengolah vector Libre CAD

1. Klik Star—>Pilih folder Libre CAD—>klik Libre CAD—> Muncul lembar kerja

libreCAD

i@ LibreCAD
[

Gambar 1.7 Mengaktifkan aplikasi Libre CAD

Membuat Dokumen Pada aplikasi Coreldraw

Langkah-langkahnya sebagai berikut :

1. Klik menu file=>Pilih New = Tentukan nama judul, ukuran, unit, jumlah lembar kerja, Pewarnaan dan

resolusi
2. Kemudian pilih “ok”

Create a New Document >
Mame:
Preset destination: |Custom ~ ||
Size: | Legal e

Width: |21.59em 2|  centimeters ~
Height: |35.56cm = [] O
Mumber of pages:

Primary color mode: | CMYK ~
Rendering resolution: | ] ~ | dpi
Preview mode: |Enhanced v
¥ Color settings
# Description

Lets you select the preview mode that most resembles the final output of
your document.

(Do not show this dialog again
oK Cancel Help

Gambar 1.8 Membuat lembar kerja baru

Membuka Dokumen Pada aplikasi Coreldraw

Langkah-langkahnya sebagai berikut :



1. Klik Menu file>Pilih open->Pilih file yang diinginkan=>kemudian pilih open

L\“ CorelDRAW X6 (64-Bit) - [Untitled-1]

N

0 (T New.. Ctrl+N
M~ Open. Ctrl+0

Leg Open Recent ¢
E'; Cloze

l‘g‘ E rlnce Al

Gambar 1.9 Membuka file

Menyimpan Dokumen pada aplikasi Coreldraw

Langkah-langkahnya sebagai berikut :
2. Klik File>Save—>(jika ingin menggunakan nama file default dari aplikasi)=>kemudian pilih save
Klik File=>Save As—> (jika ingin menggantinya dengan nama file yang baru)—=>kemudian pilih save

| CorelDRAW X6 (64-Bit) - [Untitled-1]

i‘
.l
3
]

(T New.. Ctrl+N

P~ Open. Ctrl+0
Open Recent (3]

E‘_\) Cloze i

[ Closean

| save..

B[ Saveds..

C\& ||:—ﬂ Save As Template...

Gambar 1.10 Menyimpan file

Mengakhiri lembar kerja pada aplikasi Coreldraw

Langkah-langkahnya sebagai berikut :

1. Klik File=>Pilih Exit

(T HNew.. Ctrl+M

P~ Open.. Ctrl+O
Open Recent >

E'l_}) Close

<@ Closean

e".|n Save..

[ Saveds.

l\:{.|l.'—ﬂ Save As Template...

b
[

Collect For Output... |

%I_

Publish To PDF... |
Publish Page To ConceptShare... |

Bl

+

g

'5@ Acquire Image 3

O Search Content

‘_\‘ St Import.. Cirl+|

L)

ek Export..

= % Export For Office...

'g‘. l—i‘ﬁ Export For Web...

ity |=m  Export HTML..

B |;," Send To

(“ ||:, Print... |

"\n ||;," Print Merge |
'

:E |:‘? Print Setup...

<,

*

Document Properties,..

?

Exit Alt+F4

Gambar 1.11 Keluar dari lembar kerja

Langkah-langkah membuat lembar kerja pada aplikasi Libre CAD

Langkah-langkahnya sebagai berikut :

1. Klik menu file>Pilih New - Lakukan pada pengaturan warna background,unit dan penyimpanan



X

£ Application Preferences

Appearance  Paths  Defaulis

Graphic View Graphic Colors
Snap indicator lnes Crosshair - Snap indicatar: e ~/=
P— =
Snap indicator shape Cirdle -
[ Hide cursor when snapping
ets G ol =
[ Ant-aliasing
Scrollbars
Automatically scale grid
Minimal Grid Spacing (px) 10 ~
andie Color =
Number of preview entities: 100 -
End Handle Coor =
Language
GUI Language: Engich M
Command Language: Engich M

Gambar 1.12 Membuat lembar kerja pada Libre CAD

Langkah-langkah membuat lembar kerja baru pada aplikasi open office Draw

Langkah-langkahnya sebagai berikut :

1. Klik Menu file>Pilih New->Pilih Drawing

71 Untitled 1 - OpenOffice Draw

‘| Eile Edit View [nsett Format Tools Modify Window Help

1[0 New v | B Text Document

b Open... Ctrl+0 | f#) Spreadsheet

b Recent Documents v | & Presentation

Iq (3 Wizards ., [0 Drawing Ctrl+N

@ Database
9 @ Close
| Save Cifes | £ HTML Document
Bl SoveAs. CidsShiftes | 2l XML Form Document

Save All E Master Document

1 Reload E Formula
Versions... 2 Labels

| B epor. B Business Cards
Export as PDF... P Templates and Documents
Send =

[ Propertes..
Digital Signatures...

Templates ’ :

©

Preview in Web Browser i

£y Print.. Ctrl+P ~
Printer Settings...

&

3 Exit Ctrl+Q R

Gambar 1.13 Membuat lembar kerja pada Open Office Draw

D. Silahkan simak video praktek mengaktifkan aplikasi perangkat lunak pengolah vector berikut ini :
https://youtu.be/LzwE3HKyQVo

Dalam membuat desain grafis, banyak aplikasi pengolah vector yang dapat digunakan, user dapat
memilih menggunakan aplikasi yang sesuai dengan minat,bakat dan hasil atau layout gambar yang
diinginkan. Sehingga isi dari desain grafis yang diinginkan akan tercapai

http://loplaplblogbaru.blogspot.com/2015/06/pengertian-tentang-softwaredesign.html

https://id.imjsu.com/digital-kreatif/rencana-denah/

http://www.ruangfreelance.com/download-software-desain-grafis-berbasis-vektor-gratis/
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